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iv Sage Estimating (SQL)

Version 19.11 Release Notes
This document provides important information regarding new features and changes in your Sage
Estimating 19.11 software. Read these release notes carefully before installing Sage Estimating 19.11.

Installation Notes
System Requirements
For current information about supported operating systems, Internet browsers, Microsoft® SQL Server®,
and other software, and about system requirements for servers and client workstations, refer to our
Knowledgebase article ID 99187, available at
https://support.na.sage.com/selfservice/viewdocument.do?externalId=99187.

Installing Sage Estimating
Refer to the Installation and Administration Guide for complete instructions on installing the software and
migrating or upgrading your data.

Before Installing
Important!
l

Microsoft .Net 4.6.2 is required for Estimating. If it is not already installed on your computer, the
Estimating installation will require a restart. If you prefer not to restart when installing Estimating,
first install .Net 4.6.2 from the Prerequisites folder (in the Install folder), and then restart your
computer before installing Estimating.

l

If you are upgrading to version 19.11 and you are using third-party software that integrates with
Sage Estimating, check with the third-party software vendor to ensure that their software is
compatible with version 19.11 before you upgrade.
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New Features and Enhancements
Sage Estimating version 19.11 includes the following significant improvements:
l

Database Editor improvements

l

New "shell" databases to speed up new database creation

l

Ability to copy standard databases in the Estimating Management Console

l

Other improvements in the Estimating Management Console

l

Ability to update address book by migrating changes from Sage 300 Construction and Real Estate
Accounting

l

Improved Estimate Catalog

l

Default sequence management

l

New ways to sort columns

l

Other spreadsheet improvements

l

Improved upgrade experience.

The following sections describe these changes in more detail.

Database Editor improvements
We have introduced several enhancements to the Database Editor, which are described in the next few
sections.
For more detailed information about each new feature, see the help for the Database Editor.

Work with columns more easily
With version 19.11, it's easier than ever to select, hide, and move a single column and multiple columns.
l

l

To select a single column, click the column header. clicking the header of a column that is already
selected clears the selection.
To select additional columns one at a time, press and hold Ctrl while you click the headers of the
additional columns. You can clear your selections, one at a time, in the same way.
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l

To select a contiguous range of columns, either:
l

l

Press and hold Shift while you click the furthest right (or left) column in the range and the first
(or last) column in the range.
Click a column header, then hold the mouse button down as you drag the mouse to the right
or left to select multiple columns. When you have selected the desired columns, release the
mouse button.

Tip: If you drag the mouse to left or right margins, the display scrolls so that you can extend
your selection beyond the initial display.
l

To hide columns, select one or more columns, right-click one of the selected column headers, and
then click Hide Column from the shortcut menu.

Note: Hidden columns are now marked by a visual indicator.
l

You can more easily drag and drop selected columns to a different position. For example, you can
drag one or more columns from the beginning to the end of a layout in one smooth process.
(Previously, you had to drag a column as far right as you could, drop it, manually scroll the window to
the right while keeping the column visible, repeating the drag-and-drop process until you could drop
the column in the desired location—and you could only drag and drop one column at a time.)
To move columns, select one or more columns, click one of the selected column headers, and then
drag the mouse right or left. . If you drag the mouse to left or right margins, the display scrolls so that
you can extend the display beyond the initial set of columns. Drop the columns at the column divider
where you want to relocate the selected columns. The relocated columns remain selected after you
drop them.

Copy and paste columns and rows between Excel and the Database Editor more
efficiently
Now, you select and copy only visible columns from the active layout. When you paste the copied data into
Excel, data from hidden columns is not included.
When you copy and paste an entire row from the Database Editor into Excel, the column headers from the
current layout are automatically copied into Excel. By making the record structure obvious, you can more
easily create and edit databases in Excel. For example, you can copy a single row from the Database
Editor to Excel to obtain a record template, add and edit rows (records) in Excel, and then copy and paste
the Excel data back into the Database Editor.

Note: Columns are pasted in the same order as you copied them.
When copying and pasting rows from Excel into the Database Editor:
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l

l

l

If the row has category columns, but the column is not available in the current layout, Estimating
makes the column available so that the affected column can be pasted.
If the row has a rounding precision column, but the rounding direction column is not in the current
layout, Estimating sets the rounding direction to Closest.
If the row has a Material Class description, but the Material Class column is not in the current layout,
the Material Class description remains read-only, and Estimating does not paste it.

Note: Price change dates for categories are calculated, not pasted.

Drag phases and items and drop them in new locations
In the Phase and Item grids, you can drag item or phase rows to a different location, either moving them to
or copying them at the new location.
You can drop items after an existing item in the phase tree or on the items grid.
You can drop phases after an existing phase on the phases grid.

To move or copy item or phase rows to another location:
1. On the Database Editor grid, select the row that you want to move or duplicate, and then release the
mouse.

2. To move the item or phase, click the row and then, while holding down the left mouse button, drag
the row to a different phase in the navigation pane (on the left) or to a different position on the grid.
To create a copy (Duplicate) of the row at a new location, hold down the Ctrl keys while you drag the
row to the new position.

3. Drop the row in the new location.
When you drop items, a Renumber Items or a Duplicate Items window appears, depending on
whether you are moving or copying rows. For numeric item codes, the windows display default
values for the Target phase, Start item, and Increment value fields, but you can change them.
When you drop a phase on the grid, the Renumber Phases window appears. You can specify a
starting phase number or leave the numbers unchanged. You can also change the job cost phase,
as needed. However, you cannot save the database if the phase contains duplicate items.

Note: New phase and item numbers are highlighted with a green background so that you can
easily identify the changes before saving them.
For more information about the Renumber Items, Renumber Phases, and Duplicate Items windows,
see the Database Editor help.
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4. On the ribbon, click Save.
The background of the changed rows is restored to neutral when you save the database.

Other usability improvements in Database Editor
l

l

l

l

In the Manage Layouts window, you can use a new [Rename] button to rename a selected layout.
In the Manage Filters window, you can use a new [Rename] button to rename a selected filter, and a
new [Copy] button to copy an existing filter.
You can use new Save and Save As buttons on the ribbon to save the current layout.
When you select a database phase in the navigation pane, the items grid is automatically updated to
show the items in the selected phase, with the first item in the phase at the top of the displayed area.

Work with items and phases more efficiently
You can now drag and drop (or copy and paste) items from one phase to another, and you can copy and
paste phases.
Similar to Estimating (Pervasive), default filters are now available to limit the display of items. The
installation process writes new default filters to each user's Sage roaming profile folder if they do not yet
exist in the user's profile. You can use the filters "as is," or you can use them as the basis for customized
filters.
You can paste data into an empty database. For example, if you are creating a new database from data
you set up in an Excel spreadsheet, you can simply copy and paste the items into a new row.
When you select an invalid row, the background color changes so that you can tell that it has been
selected. Previously, selected invalid rows had no indication that they had been selected.

Changes to column sorting
You must now hold down the Alt key while sorting on a column. (If you do not hold down the Alt key, you
simply select columns.)
In summary:
l

To sort on a single column in ascending order, hold down the Alt key while you click the header of an
unsorted column.

l

To sort in descending order, hold down the Alt key while you click the header again.

l

To undo sorting on a column, hold down the Alt key while you click the header one more time.

l

To sort on multiple columns, first, sort the first column in the range of columns. Then, hold down the
Alt and Shift keys while you click the header of the next column in the sort range. Add more columns

Sage Estimating (SQL) v19.11 Release Notes

5

to the range in the same manner.
You reverse the sort order by holding down the Alt and Shift keys while you click the header a
second time.
To remove a column from the sort group, hold down the Alt and Shift keys while you click the header
a third time.

New shell databases to speed up new database creation
If you are new to Sage Estimating and you have been maintaining item lists and estimates in Excel or
another spreadsheet program, the prospect of creating a database from scratch for Sage Estimating might
be daunting. We want to help make that process easier for you, so you can become productive quickly.
Version 19.11 comes with the following "shell" databases that include standard CSI phase codes, but no
items:
l

Shell Commercial General contracting. This database includes only phases commonly used by
commercial general contractors.

l

Shell CSI 1995. This database uses the 16 divisions from the old MasterFormat 1995 Specification.

l

Shell CSI 2011. This database uses the 50 divisions from the MasterFormat 2011 Specification.

If you need to create a database to house your own item list, you can install one of these databases using
the Estimating Management Console. Then, using the Database Editor, you can easily populate the
database by adding your own items to the standard phases or by transferring existing items from Excel.
For more information, see Creating a new database from Excel data in the Database Editor help.

Ability to copy standard databases in the Estimating
Management Console
You can use the new Copy tool in the Estimating Management Console to create a new standard or cost
database by copying an existing one.
The program creates a temporary backup file, and then "restores" it under a new database name that you
specify.
For more information about copying databases, see the Copying Databases help topic.

Other improvements in the Estimating Management Console
Version 19.11 includes the following additional improvements:
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l

We have removed the Make Available capability from the Estimating Management Console and the
Manage Estimates window.
To prevent data corruption, Sage Estimating no longer enables you to unlock another user's
estimate.

l

In the Estimating Management Console, new [Select All] and [Clear All] buttons in the Backup,
Restore, and Optimize panes enable you to select or to clear the all the names in the list.

l

In the Estimating Management Console, when you select a database in the Catalog pane, a new
Created By field displays the ID of the user who installs a standard database or address book, or
adds an estimate using the Estimating Management Console

l

In the Estimating Management Console, we have added a new Delete login(s) from SQL Server
instance option to the Delete User(s) dialog box. If you select this option, the program removes the
user's login from the instance as well as from the Estimating program.

Update address book by migrating changes from Sage 300
Construction and Real Estate
Version 19.11 enables any user that has new limited management rights to remigrate the Address Book
from Sage 300 Construction and Real Estate Account. Previously, only Sage Estimating administrators
could migrate any data.
Also, importantly, when you remigrate the Address Book, the migration program updates existing entries in
the Estimating address book with any changes processed in Sage 300 Construction and Real Estate since
you last migrated the Address Book, if the changes are more recent than any made in the Estimating
Address Book.

Assigning limited Migrate Data permission to non-administrators
To enable non-administrators to migrate Address Book data, version 19.11 introduces a new permission
level that you can assign to non-administrator roles: Migrate data (limited). You assign this permission in
the Estimating Management Console.

Note: Users who also have Create estimate permission can migrate estimates.

Updating address book contacts
With Migrate data (limited) permission, any user with access to the Estimating Management Console can
update a previously migrated Address Book with any changes that were subsequently process in Sage 300
Construction and Real Estate.
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Improved Estimate Catalog
The Estimate Catalog presents all your estimates in a tree-like view when you open or manage estimates.
In version 19.11, we have introduced improvements to make it even easier to work in the Estimate Catalog.
The Estimate Catalog is now more responsive, enabling you to navigate more easily and accomplish more
tasks with fewer clicks. When you make changes to the catalog (for example, renaming, copying, moving,
or deleting estimates), the catalog is refreshed much faster.
When you click a branch in the Estimate Catalog (for example, All Estimates), all the estimates associated
with that branch appear immediately in a grid in the right-hand pane. The grid displays key information
about each estimate as you navigate the estimate catalog. You can even filter the display to show only
estimates for a specified estimator, for example, so you can find the estimate you want more quickly. You
can also export the contents of this grid to an Excel file by clicking the Export button above the grid in the
right-hand pane.
You can select multiple estimates in the Estimate Catalog, and then perform processes on those estimates
simultaneously. For example, you can select several estimates, and then move (drag and drop), delete, or
export all the estimates at once. If you export selected multiple estimates from the Estimate Catalog pane,
the estimates are preselected in the Export window.
You can drag multiple selected estimates to the branch node or anywhere on the branch. Dropping the
estimates locates them on that branch. As you drag the estimates to a different location on the tree, hint
text on your screen indicates the current location until you drop them in their new location. If you press and
hold down the Ctrl key while you drag the estimates to a different branch, the program creates copies of
the original estimates and places the copies in a new location.
The Copy Estimate window is now called Duplicate Estimate, and the corresponding function on the
shortcut menu (when you right-click an estimate in the Estimate Catalog) is also called Duplicate. The
advantage of the Duplicate Estimate window over using the drag-and-drop method or the Copy function is
that you can adjust some settings for the new estimate as you create the duplicate.
We have also improved the toolbar in the navigation pane:

l

There is a new Delete icon. Select estimates in the Estimate Catalog pane, and then click the Delete
icon to remove the estimates.

l

We have replaced the old Copy and Paste icons with modern-looking Copy and Paste icons. (We
have also renamed the corresponding options in the shortcut menu to match the new toolbar.)

Sage Estimating (SQL) v19.11 Release Notes

8

Default sequence management
Spreadsheet sequences group items in a logical, hierarchical order, arranging information in ways that
highlight different aspects of your estimates. You can easily switch between sequences to obtain a
different view of an estimate—for example, to a sequence that enables you to perform a task efficiently.
Previously, you could save sequences associated with the current database as default sequences.
However, there was no easy way to add or remove default sequences without replacing the entire list.
In version 19.11, you can create and manage a list of standard spreadsheet sequences for each standard
database. Because Estimating maintains these sequences separately for each database, you can create
customized default sequences for each database. Then, when you create an estimate using a particular
standard database, the list of spreadsheet sequences from that database is copied to the new estimate by
default.

Note: Existing estimates are not affected by these changes to database spreadsheet sequences, but
you can manually add them to existing estimates as needed.
If you want to use the same default sequences across multiple databases, after setting up default
sequences in one database, you can export them, and then import them into additional databases.
You use the new Select/Edit Default Spreadsheet Sequences window to view, edit, or remove default
spreadsheet sequences associated with a database, and add new ones. You also use this window to
select the default spreadsheet sequences you want to copy to the current estimate.

Note: To support these changes, we redesigned the existing Edit Estimate Spreadsheet Sequences
window, as follows:
l

l

We removed the Save as Default option, which is no longer needed.
We added a new [Database] button. You click this button to open the Select Default Spreadsheet
Sequences window.

For more information, see Select/Edit Default Spreadsheet Sequences window in the Estimating help.

New ways to sort items in spreadsheet columns
In Estimating, you use spreadsheet sequences to group spreadsheet items in a logical, hierarchical order.
By organizing an estimate this way, you can easily view the information that is most important to you.
Now, you can sort items within each overline in the current spreadsheet sequence in ascending or
descending order, enabling you to display information in even more meaningful ways.
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Example: You are viewing an estimate using a spreadsheet sequence grouped by phase. You want to
see items with the largest labor amounts first within each phase group, so you decide to sort the contents
of the Labor Amount in descending order. You simply right-click the Labor Amount column header, and
then select Sort Descending from the shortcut menu (or press the Alt key while you click the column
header).
You can also sort on additional multiple columns by selecting the Add to Sort Ascending/Descending
option from the shortcut menu (or press Shift + Alt while you click the column header). An up or down arrow
in the column header indicates the direction of the sort on that column, while a number in the header
indicates the order in which each you applied each sort to the spreadsheet.
To remove the sort on all the columns in the current sequence, click the Clear Sort option on the shortcut
menu.
For steps on sorting columns, see Sorting columns in ascending or descending order in the Estimating
help.

Note: This sorting feature provides a quick way to reorder the items in the current spreadsheet
sequence. For this version, sorts you perform on one spreadsheet sequence do not carry over to other
sequences and are not saved to the layout. For future versions, we hope to provide sorting and reuse
capabilities that are of most use to you. Use the Estimating Help menu to tell us your ideas for the future
development of this feature:
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Other spreadsheet improvements
l

You can enter multiple, named notes for an estimate in the Estimate Notes window. You enter the
notes on individual tabs that you add and name. You can also rename tabs or delete them.
For more information, see Estimate Notes window in the Estimating help.

l

The current column and row headings are now highlighted automatically when you select a cell on
the Estimating spreadsheet.
You can also highlight the entire current row (or turn the row-highlighting feature off) using a new
spreadsheet option. Select File > Options > Sage Estimating Application > Spreadsheet > Highlight
current row in spreadsheet.

l

Where the full text of some fields is not visible (such as WBS values, Addons, Unit Descriptions)
because it is too long to fit in the cell, you can hover over the cell to view the complete text.

l

We have added new keyboard shortcuts to the spreadsheet and docking panes. For more
information, see the help topic, Keyboard Shortcuts.

l

You can use a new Arrange All window to display spreadsheet windows horizontally or vertically.
You open the window by clicking new Arrange All icon in the View section on the ribbon, or by
pressing [Ctrl]+[Shift]+[W].

Note: To use this feature you must clear the Display estimates in tabs option.
l

We have added a new Created By field to the status bar on the spreadsheet and to the estimate grid
in the Estimating Management Console, so you can see who created a standard database or a
selected estimate.

l

You can enter multiple, named notes for an estimate in an improved, tabbed Estimate Notes
window. You can open the Estimate Notes window using a new Notes icon in the Estimate Views
group on the ribbon, or from the Estimate Information window (as in earlier versions).
You enter notes for an estimate on individual tabs that you can add, rename, and remove. (You
cannot rename the default General tab, however.) For more information, see the help for the
estimate Notes window.

l

l

When you combine spreadsheet items that use alternates, all the alternates for the combined item
must have the same inclusion status (either all included or all excluded). Combined items can have
different alternates, provided that their inclusion statuses are the same.
You can now add subcategory values "on the fly" on the spreadsheet, if the values do not already
exist in the standard database.
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Improved upgrade experience
During the upgrade process, the program now shrinks the existing log file, which can become very large,
and it removes invalid estimates. However, it does so only if the database recovery model is set to Simple.
We do not recommend that you change the recovery model unless your business requires features
available only in a different model.
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Fixes Since the Previous Version
Version 19.11 includes the following fixes:
l

In the Database Editor:
l

l

l

When you save a layout, locked columns are now saved as part of the layout.

l

You can again import Excel (XLS) files to update prices.

l

You can reopen a checked-in database from the Recently used list.

l

Clicking the Help button (or pressing F1) now displays the correct help topic.

In the Estimating Management Console:
l

l

l

When you clear an item category selection on the item grid, any job cost phase that was
entered for the item remains intact, although it doesn't appear in the grid.

When integrating with Sage 300 Construction and Real Estate Job Cost, if a job number field
has an error, you can select a valid number or enter a blank to clear the error.

l

You can migrate an Options file even if it includes layouts for reports that do not exist in
Estimating (SQL).

l

You can optimize a database even if page-level locking is turned off for the database.

When exporting to Sage 300 Construction and Real Estate Job Cost, you can now:
l

Map estimate information to WBS values with the Use all WBS values option.

l

Export job costs for an item that has non-zero units but a zero price and amount.

In the spreadsheet:
l

l

l

When choosing a new WBS value, the list of WBS values scrolls down to the current value (if
there is one).
When you sort items by subcontractor for an estimate, then open the bid grid and select
another subcontractor for an item, the item is correctly assigned to the new subcontractor.
We have fixed some display issues that could occur in the spreadsheet with high resolution
monitors. For example, now tips are legible when you hover over assembly variables.
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l

l

l

l

Estimating now saves the zoom level that you last used for the spreadsheet layout so that you
don't have to reset the zoom next time you apply the layout.

When you reprice labor and equipment for a crew, updating the estimate rate tables and updating
crews from the database:
l

The report completion message appears only once.

l

The Estimating application no longer closes.

When you search for items during takeoff, results include all items that contain any of the words
used in your search, regardless of their order. For example, if you search for "wood frame," the
results would include "wood door frame," even though "door" is interposed between "wood" and
"frame."
During Assembly Takeoff:
l

l

You can undo more than one pass with select-at-takeoff lines.
When you take off an assembly, and then change a variable in a pass, the replaced pass
contains the correct quantities.

l

Estimating does not stop working when you select a model in the Check Model window.

l

For Sage Estimating reports:
l

The company name now comes from the estimate information, rather than your customer
registration name.

l

Reports that you export to a CSV file now include only the columns that are visible on the
layout.

l

Report cover pages for the Standard and Spreadsheet reports are justified properly when you
use job classifications for the estimate.

l

We have adjusted the margins of the Spreadsheet report to align with the report header.

l

When you use the Prefill from Spreadsheet function in the Report Options window,
Estimating:
l

Now updates the Show level total separator lines option correctly.

l

No longer selects the New Page for each setting inappropriately.

l

l

No longer automatically sets the New page for totals option for sort sequences that
have more than two sort levels.

The Spreadsheet Report now prints an assembly's items in the same order used for the
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assembly.
l

l

Aggregated quantities are now calculated properly when you generate a custom report.

When you transfer Means items to a standard database that uses a 0-digit phase suffix, items are
correctly left justified so that they are not omitted when you apply city cost index factors.
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Fixes Included in Revisions to
Version 19.11
We have included a number of fixes in revisions to the software since releasing version 19.11.

Build 19.11.1910.071 (October 2019)
This build includes the following software fixes, plus fixes included in earlier builds:
l

Certain application settings no longer cause the program to stop when you launch estimates from
the Manage Estimates window.

l

Addon amounts now appear when you open an estimate with allocated addons.

l

Passing parameters to sub-reports in custom reports now works as expected.

Build 19.11.1908.281 (September 2019)
l

We resolved an issue that could prevent you from migrating Estimating (Pervasive) data that
includes models to Estimating (SQL).

l

You no longer receive a Foreign Key error when taking off items with a material class that is new to
the estimate.

l

The item list refreshes properly when you scroll through the list. (Previously, scrolling the selected
item off the screen could cause a duplicate item to appear in the list.)

l

Addons appear correctly on the Totals page after you change the Calculate crew items for base rate
only setting for the addon.
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Known Issues
Negative values are not sorted in order
When you sort the spreadsheet on individual numeric amount columns, negative values do not appear in
the correct order.

SAP Crystal Reports compatibility with other Sage programs
Version 19.11 uses the SAP Crystal Reports Runtime version 13.0.22, which is not compatible with Crystal
Reports used in these versions of other Sage programs:
l

Sage 300 Construction and Real Estate v17.1 and v18.1.
To ensure that you can run and print your Sage 300 accounting reports, you must use Sage 300
Construction and Real Estate v18.2 or later with Sage Estimating v19.11.

l

Sage Fixed Assets 2018.0.
If you use Sage Fixed Assets on the same computer as Sage Estimating, you must use Sage Fixed
Assets 2018.1, or later, with Sage Estimating v19.11.

For more information, see Knowledgebase article KB 93436.

Problem with migrated standard databases and estimates that
used a job cost interface
If you migrated a standard database or an estimate that was integrated with job cost in Estimating
(Pervasive), you need to perform a few additional steps to reintegrate the standard database or estimate in
Estimating (SQL).

Important! Until you perform the following steps, you will receive a Job Cost Interface Failure error when
you try to edit job cost settings for a standard database or an estimate that was integrated with job cost in
Estimating (Pervasive). Also, you will not be able to use the standard database with new interfaced
estimates in Estimating (SQL).
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Before you start
You need to be assigned to a role with Run Management Console, Edit Standard Databases, Edit
Standard Database Settings permissions, and have Edit access to the estimates to use the job cost
system setup.

For each migrated standard database that used a job cost interface in Estimating
(Pervasive):
1. In the Estimating Management Console, click Standard DB on the ribbon.
2. In the Standard Database Catalog, select the migrated standard database.
3. In the details pane to the right, click [Edit]
4. In the Job Cost Information section:
a. For the Job cost system name, select either None or Text.
b. Click [Save].
c. For the Job cost system name, select Sage 300 Construction.
d. Click [Setup], and enter the job cost settings required to reintegrate the database with Sage
300 Construction.

5. Click [Save].
6. Repeat steps 2 through 5 for each migrated estimate that used the job cost interface in Estimating
(Pervasive).

Note: To edit estimates, you must first click Estimates on the ribbon, and then (in step 2) you
select the estimate from the Estimate Catalog.

Checking in a Standard Database from the Database Editor
Closes the Database for Concurrent Users
You can work on a Standard database in the Estimating Database Editor while other users perform takeoff
using the same database in the Sage Estimating program.
When you try to check in the Standard database while other users have the database open, you receive a
warning that if you continue to check the file in, there may be unpredictable results for the concurrent
users.
If you continue to check the file in despite the warning, the Estimating program stops working for the other
users. However, the data is not corrupted and the Estimating program is not damaged.
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Further Assistance
Sage provides you with the following resources for obtaining assistance with Sage Estimating.

Online Help
The Sage Estimating software includes online Help, which provides answers to your questions about
procedures as well as items in the windows.
To view Help in the Sage Estimating software, click the Help button or icon, or press [F1] to display the Help
topic for that window.
For more information about using the online Help, see the Sage Estimating Help.

Training
Sage University offers online and classroom training sessions to help you get the most out of your Sage
Estimating software. To access Sage University, visit www.sageu.com.
You can also get access to Sage University from the File menu by selecting Help > Sage University.

Technical Assistance
When you need assistance, refer to the Knowledgebase article How do I get technical support for Sage
Estimating? to determine which service works best for you.

Submitting Enhancement Requests
We want to hear your suggestions for improving the software. To send us your comments, click on the File
menu button

and select Help > Submit Product Idea.
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